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Preface

Safety information

Note: For general safety information, see this Preface and Appendix C, “Safety” on
page 93. When a hazard symbol and hazard type appear by an instrument hazard, see
the “Safety” Appendix for the complete alert. For all chemicals, read the SDS and
follow the handling instructions. Wear appropriate protective eyewear, clothing, and
gloves.

Safety alert  Four safety alert words appear in Applied Biosystems user documentation at points
words in the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

C WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the
most extreme situations.

SDSs The Safety Data Sheets (SDSs) for any chemicals supplied by Applied Biosystems or
Ambion are available to you free 24 hours a day. For instructions on obtaining SDSs,
see “Obtaining SDSs” on page 95.

IMPORTANT! For the SDSs of chemicals not distributed by Applied Biosystems or
Ambion contact the chemical manufacturer.
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Overview

This chapter covers:

B ProduCt OVeIVIEW . . . ottt e e e 10
B WOrkflow OVEIVIEW . . . .ottt e e e e e 14
B Instrument and software OVerview. . ...t 15
B Materials and equipment . . .. ... 17
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Chapter 1 Overview

Product overview

Purpose

Product
description

About the primers

The AmpF(STR® NGM™ PCR Amplification Kit is a short tandem repeat (STR)
multiplex assay that amplifies 14 tetranucleotide repeat loci and one trinucleotide
repeat locus, D22S1045. The kit simultaneously coamplifies the 10 loci contained in
the AmpF(STR® SGM Plus® kit (D3S1358, vWA, D16S539, D2S1338, D8S1179,
D21S11, D18S51, D19S433, THO1, and FGA) together with 2 highly polymorphic
STR loci (D1S1656 and D12S391), 3 “mini” STR loci (D10S1248, D22S1045 and
D28S441), and the gender determination locus Amelogenin. The AmpF(STR® NGM™
Kit delivers a 16-locus multiplex with a greater power of discrimination, better
sensitivity, and improved robustness than earlier generation kits. The kit uses
modified PCR cycling conditions for enhanced sensitivity, a new buffer formulation
to improve performance with inhibited samples, more loci concentrated in the low
molecular-weight region of the profile to improve performance on degraded samples,
and an improved process for synthesis and purification of the amplification primers
to deliver a much cleaner electrophoretic background.

The AmpF(STR® NGM™ Kit contains all the necessary reagents for the
amplification of human genomic DNA.

The reagents are designed for use with the following Applied Biosystems
instruments:

» Applied Biosystems 3500/3500xL Genetic Analyzer

+ ABI PrisM® 3100/3100-4vant Genetic Analyzer

* Applied Biosystems 3130/3130x/ Genetic Analyzer

» Applied Biosystems 310 Genetic Analyzer

+  GeneAmp® PCR System 9700 with the Silver 96-Well Block

+  GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

The AmpF(STR® NGM™ Kit employs the latest improvements in primer synthesis
and purification techniques to minimize the presence of dye-labeled artifacts. These
improvements result in a much cleaner electropherogram background that enhances
the assay's signal-to-noise ratio and simplifies the interpretation of results.

10
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Product overview

Loci amplified by

the kit

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AmpF(STR® NGM™ Allelic Ladder is
used to genotype the analyzed samples. The alleles contained in the allelic ladder and
the genotype of the AmpF(STR® Control DNA 007 are also listed in the table.

Table 1 AmpF(STR® NGM™ Kit loci and alleles

. . Chromosome Alleles included in AmpF/STR® NGM™ Dye Control DNA
Locus designation location Kit Allelic Ladder label 007

D10S1248 10026.3 8,9, 10, 11,12, 13, 14, 15, 16, 17, 18 6-FAM™ 12,15

vWA 12p13.31 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, | 6-FAM™ 14,16
23,24

D16S539 16924.1 5,8,9,10,11,12,13, 14,15 6-FAM™ 9,10

D2S1338 2935 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 6-FAM™ 20, 23
26, 27, 28

Amelogenin X: p22.1-22.3 X, Y VIC® X, Y

Y: p11.2

D8S1179 8024.13 8,910, 11,12, 13, 14, 15,16, 17, 18, 19 VIC® 12,13

D21S11 21q11.2-g21 24,24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, VIC® 28, 31
30.2, 31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2,
35, 35.2, 36, 37, 38

D18S51 18921.33 7,9,10,10.2,11,12,13,13.2,14,14.2,15, | VIC® 12,15
16, 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27

D22S51045 22q12.3 8,9,10, 11,12, 13, 14, 15, 16, 17, 18, 19 NED™ 11,16

D19S433 19qg12 9,10, 11,12,12.2, 13, 13.2, 14, 14.2, 15, NED™ 14,15
15.2,16,16.2,17,17.2

THO1 11p15.5 4,5,6,7,8,9,9.3,10, 11, 13.3 NED™ 7,9.3

FGA 4928 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, NED™ 24,26
27, 28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2,
43.2,44.2,45.2,46.2,47.2,48.2,50.2,51.2

D2S441 2p14 9,10, 11,11.3, 12, 13, 14, 15, 16 PET® 14,15

D3S1358 3p21.31 12,13, 14,15,16,17,18, 19 PET® 15, 16

D1S1656 1042.2 9,10, 11,12, 13, 14, 14.3, 15, 15.3, 16, PET® 13, 16
16.3,17,17.3, 18.3, 19.3, 20.3

D12S391 12p13.2 14,15,16, 17,18, 19, 19.3, 20, 21, 22, 23, PET® 18, 19
24,25, 26, 27
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Chapter 1 Overview

Allelic ladder Figure 1 shows the allelic ladder for the AmpF{STR® NGM™ Kit. See “Allelic ladder
profile requirements” on page 34 for information on ensuring accurate genotyping.
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Figure 1 GeneMapper® ID-X Software plot of the AmpF(STR® NGM™ Kit Allelic
Ladder
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Product overview

Control DNA 007 Figure 2 shows amplification of Control DNA 007 using the AmpF(STR® NGM™

profile Kit.
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Figure 2 1 ng of Control DNA 007 amplified with the AmpF/(STR® NGM™ Kit and
analyzed on the Applied Biosystems 3130x/ Genetic Analyzer
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Chapter 1 Overview

Workflow overview

Extract DNA

AutoMate Express™ Forensic DNA Extraction System with
PrepFiler Express™ Forensic DNA Extraction Kit

¥

Quantify DNA

Quantifiler® Duo DNA Quantification Kit

\ 4

Perform PCR
AmpF(STR® NGM™ PCR Amplification Kit

GeneAmp® PCR System 9700 Thermal Cycler*

* Amplification should be performed on silver- orgold-plated
silver 96-well blocks only.

\ 4

Perform Electrophoresis

o o ok B

ABI PRISM® ABI PRISM® Applied Biosystems Applied Biosystems

310 Genetic ~ 3100/3100-Avant 3130/3130x!( 3500/3500xL
Analyzer Genetic Analyzer Genetic Analyzer Genetic Analyzer
for Human

Identification

A 4

Analyze Data

GeneMapper® [D-X or GeneMapper® /D Software
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Instrument and software overview

Instrument and software overview

Data Collection
and
GeneMapper® ID
or ID-X Software

Instrument and
software
compatibility

About
multicomponent
analysis

This section provides information about the Data Collection Software versions
required to run the AmpF(STR® NGM™ PCR Amplification Kit on specific

instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software
stores information about each sample in a sample file (.fsa), which is then analyzed
by the GeneMapper® ID or ID-X Software.

Table 2 Software specific to each instrument

Operating Data Collection .
Instrument system Software Analysis software

3500/3500xL e Windows® XP | 3500 Series GeneMapper® ID-X Software

e Windows Data Collection | v1.2

Vista® Software v1.0
3130/3130x/* Windows® XP 3.0 e GeneMapper® /D
Software v3.2.1
3100/3100- Windows NT® 1.1 (3100) and
Avant
1.0 (31 OO-Avant) . GeneMapper® ID-X
X Software v1.0.1 or higher

Windows 2000 2.0
310 Windows XP 3.1

Windows NT and 3.0

Windows 2000

1 Applied Biosystems conducted validation studies for the AmpF(STR® NGM™ Kit using this

configuration.

Applied Biosystems fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different

colored dyes.

Multicomponent analysis is the process that separates the 5 different fluorescent dye
colors into distinct spectral components. The 4 dyes used in the AmpF¢(STR® NGM™
PCR Amplification Kit to label samples are 6-FAM"™, VIC®, NED™, and PET® dyes.
The fifth dye, LIZ®, is used to label the GeneScan™ 500 LIZ® Size Standard.

AmpF&TR® NGM™ PCR Amplification Kit User’s Guide 15



Chapter 1 Overview

How
multicomponent
analysis works

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Applied Biosystems and ABI PRISM®
instruments, the fluorescence signals are separated by diffraction grating according
to their wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM™ dye emits at the shortest wavelength and it
is displayed as blue, followed by the VIC® dye (green), NED™ dye (yellow), PET®
dye (red), and LIZ® dye (orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes
(Figure 3). The goal of multicomponent analysis is to correct for spectral overlap.

Dyes

6-FAM VIC NED PET LIZ
c 100 1 1 1 1 1
kel 4
3 80 A
E 4
L 60 4
3 |
N 40
© |
g 20 1 \
o |
=z 0 e ———

T T T T T T T T T T T T T T T T T T T T

500 550 600 650 700

Wavelength (nm)

Figure 3 Emission spectra of the five dyes used in the AmpF(STR® NGM™ Kit
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Materials and equipment

Materials and equipment

Kit contents and
storage

reaction volume.

The AmpF(STR® NGM™ PCR Amplification Kit contains materials sufficient to
perform 200 (Part no. 4415020) or 1000 (Part no. 4415021) amplifications at a 25 uL.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.

Protect the primer set from light when not in use. Amplified DNA, AmpF(STR®
NGM™ Allelic Ladder, and GeneScan™ 500 LIZ® Size Standard should also be
protected from light. Keep freeze-thaw cycles to a minimum.

Table 3 Kit Contents and Storage

Component

Description

200X Volume

1000X Volume

Storage

AmpF(STR® NGM
Primer Set

Contains forward and reverse
primers to amplify human DNA
targets.

1 tube, 1.0 mL

1 bottle, 5.0 mL

-15to -25°C on
receipt, 2to 8 °C
after initial use

AmpF(STR® NGM
Master Mix

Contains enzyme, salts, dNTPs,
carrier protein, and 0.05%
sodium azide.

2 tubes, 1.0 mL
each

1 bottle, 10.0 mL

-15to -25°C on
receipt, 2to 8 °C
after initial use

AmpF(STR® NGM
Allelic Ladder

AmpF(STR®
Control DNA 007

Contains amplified alleles.

See Table 1 on page 11 for a list
of alleles included in the allelic
ladder.

Contains 0.10 ng/pL human
male 007 DNA in 0.02% sodium
azide and buffert.

See Table 1 on page 11 for
profile.

1 tube, 50.0 pL

1 tube, 0.3 mL

1 tube, 75.0 pL

1 tube, 0.3 mL

-15to -25°C on
receipt, 2 to 8°C
after initial use

2to 8°C

1 The AmpF(STR® Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control (to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF{(STR® Control DNA 007 is not
designed to be used as a DNA quantitation control, and laboratories may expect to see variation from the labelled concentration when
quantitating aliquots of the AmpF(STR® Control DNA 007.

Standards for
samples

For the AmpF(STR® NGM™ Kit, the panel of standards needed for PCR
amplification, PCR product sizing, and genotyping are:

+ Control DNA 007 — A positive control for evaluating the efficiency of the
amplification step and STR genotyping using the AmpF(STR® NGM™ Allelic

Ladder.

+  GeneScan™ 500 LIZ® Size Standard — Standard used for obtaining sizing
results. It contains 16 single-stranded labeled fragments of: 35, 50, 75, 100, 139,
150, 160, 200, 250, 300, 340, 350, 400, 450, 490, and 500 nucleotides. This
standard, which has been evaluated as an internal size standard, yields precise
sizing results for AmpF(STR® NGM™ Kit PCR products. Order the
GeneScan™ 500 LIZ® Size Standard (Part no. 4322682) separately.

AmpF&TR® NGM™ PCR Amplification Kit User’s Guide
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Chapter 1 Overview

+  AmpF(STR® NGM™ Allelic Ladder — Allelic ladder developed by
Applied Biosystems for accurate characterization of the alleles amplified by the
AmpF(STR® NGM™ Kit. The AmpF(STR® NGM™ Allelic Ladder contains
most of the alleles reported for the 15 autosomal loci. Refer to Table 1 on
page 11 for a list of the alleles included in the AmpF{STR® NGM™ Allelic
Ladder.
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PCR Amplification
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PCR Amplification

This chapter covers:
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Chapter 2 PCR Ampilification

PCR work areas

Work area setup
and lab design

PCR-setup tools

Many resources are available for the appropriate design of a PCR laboratory:

+  For AmpF(STR® NGM™ PCR Amplification Kit forensic DNA testing, refer to:
National Institute of Justice Office of Law Enforcement Standards. 1998.
Forensic Laboratories: Handbook for Facility Planning, Design, Construction
and Moving. Washington, DC: National Institute of Justice. 76 pp.

+ For AmpF{STR® NGM™ Kit parentage DNA testing, refer to: American
Association of Blood Banks. 2004. Guidance for Standards for Parentage
Relationship Testing Laboratories. 7th ed. Bethesda, Md: American Association
of Blood Banks. 58 pp.

The sensitivity of the AmpF(STR® NGM™ Kit (and other PCR-based tests) enables
amplification of minute quantities of DNA, necessitating precautions to avoid
contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

To prevent contamination by human DNA, be careful while handling and processing
samples. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: These laboratory design resources and guidances constitute only a sample of
the precautions that need to be observed when using PCR technology. Refer to your
laboratory’s internal policies and procedures for additional information and
references.

IMPORTANT! These items should never leave the PCR setup work area.

» Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes (1.5-mL or 2.0-mL), or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack

* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors

» Tube decapper, autoclavable

* Vortex

Amplified DNA  The following GeneAmp® PCR systems should be placed in the amplified DNA
work area tools  work area.

+  Silver block 96-Well GeneAmp® PCR System 9700
+ Gold-plated Silver block 96-Well GeneAmp® PCR System 9700

22
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Required user-supplied materials and reagents

Required user-supplied materials and reagents

Kit contents and
storage

User-supplied
reagents

The AmpF(STR® NGM™ PCR Amplification Kit is available as either a
200-reaction kit or 1000-reaction kit. The number of reactions is based on a 25 puL
reaction volume. See “Kit contents and storage” on page 17 for details on kit
contents.

In addition to the AmpF/STR® NGM™ Kit reagents, the use of low TE buffer
(10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as
described in the procedure below or order it from Teknova (Cat # T0223).

To prepare low TE buffer:

1. Mix together:
* 10 mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes based on your specific needs.

2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Importance of
quantification

Quantifying the amount of DNA in a sample before amplification allows you to
determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount
of DNA for the AmpF{(STR® NGM™ Kit is 1.0 ng in a maximum input volume of
10 uL. amplified for 29 cycles.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the instrument (“off-scale” data). Off-scale data are problematic because:

— Quantification (peak height and area) for off-scale peaks is not accurate.
For example, an allele peak that is off-scale can cause the corresponding
stutter peak to appear higher in relative intensity, thus increasing the
calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

» Incomplete A-nucleotide addition.
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Chapter 2 PCR Ampilification

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur, resulting in a partial profile.

Methods of  Applied Biosystems provides several kits for quantifying DNA in samples. See the
quantifying DNA  references cited in the following table for details about these kits.

Product Description References

Quantifiler® Human DNA Properties: Quantifiler® Human DNA
Quantification Kit The Quantifiler® Human and Quantifiler® Y Quantification Kits User’s Manual

(Part no.4343895) Human Male Kits are highly specific for human (Part no. 4344790)
and DNA, and they detect total human or male DNA,
Quantifiler® Y Human Male respectively. The kits detect single-stranded and

DNA Quantification Kit degraded DNA.
(Part no. 4343906) How they work:

The Quantifiler® DNA Quantification Kits consist
of target-specific and internal control 5
nuclease assays.

The Quantifiler® Human and Quantifiler® Y
Human Male Kits contain different target-
specific assays (human DNA or human male
DNA, respectively) that each consist of two
locus-specific PCR primers and one TagMan®
MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each
contain a separate internal PCR control (IPC)
assay that consists of an IPC template DNA (a
synthetic sequence not found in nature), two
primers for amplifying the IPC template DNA,
and one TagMan® MGB probe labeled with VIC®
dye for detecting the amplified IPC DNA.

Quantifiler® Duo DNA Properties: Quantifiler® Duo DNA
Quantification Kit Quantification Kit User's Manual

I ® . . . g
(Part no. 4387746) The Quantifiler® Duo Kit is highly specific for (Part no. 4391294)

human DNA and combines the detection of both
total human and male DNA in one PCR
reaction.The kit detects single-stranded and
degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit
consists of target-specific and internal control 5'
nuclease assays.

The Quantifiler® Duo kit combines two human-
specific assays in one PCR reaction (for total
human DNA and human male DNA). The two
human DNA specific assays each consist of two
PCR primers and a TagMan® probe. The
TagMan® probes for the human DNA and human
male DNA assays are labeled with VIC® and
FAM™ dyes, respectively. In addition, the kit
contains an internal PCR control (IPC) assay
similar in principle to that used in the other
Quantifiler kits, but labeled with NED™ dye.

24 AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



Prepare the amplification kit reactions

Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using

the table below.
DNA sample Volume per reaction (uL)
AmpF(STR® NGM™ Master Mix 10.0 uL
AmpF(STR® NGM™ Primer Set 5.0 L

Note: Include additional reactions in your calculations to provide excess
volume for the loss that occurs during reagent transfers.

2. Prepare reagents. Thaw the AmpF(STR® NGM™ Master Mix and the
AmpF(STR® NGM™ Primer Set, then vortex the tubes for 3 seconds and
centrifuge them briefly before opening.

IMPORTANT! Thawing is required only during first use of the kit. After first
use, reagents are stored at 2—8°C and, therefore, do not require subsequent
thawing. Do not refreeze the reagents.

3. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 15 pL of reaction mix into each reaction well of a MicroAmp® Optical
96-Well Reaction Plate or each MicroAmp® tube.

6. Prepare the DNA samples:

DNA sample To prepare...

Negative control Add 10 pL of low TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).

Test sample Dilute a portion of the test DNA sample with low TE buffer so
that 1.0 ng of total DNA is in a final volume of 10 yL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 10 pL of 007 control DNA (0.1 ng/pL) to provide 1.0 ng of
total DNA in the positive control reaction.

The final reaction should be 25 pL.

7. Seal the MicroAmp® Optical 96-Well Reaction Plate with MicroAmp® Clear
Adhesive Film or MicroAmp® Optical Adhesive Film, or cap the tubes.
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8. Centrifuge the tubes or plate at 3000 rpm for about 20 seconds in a tabletop
centrifuge (with plate holders if using 96-well plates) to remove bubbles.

9. Amplify the samples in a GeneAmp® PCR System 9700 with the Silver 96-well
block, or a GeneAmp® PCR System 9700 with the Gold-plated Silver 96-well
block.

Note: The AmpF(STR® NGM™ Kit is not validated for use with the
GeneAmp® PCR System 9700 with the Aluminium 96-well block. Use of this
thermal cycling platform may adversely affect the performance of the
AmpF(STR® NGM™ Kit.

Perform PCR

/!\ WARNING! PHYSICAL INJURY HAZARD. Thermal cycler.

1. Program the thermal cycling conditions.

IMPORTANT! When using the GeneAmp PCR System 9700 with either 96-well
silver or gold-plated silver block, select the 9600 Emulation Mode.

Initial Cycle (29/30 cycles) Final Final
incubation step extension @ hold
Denature = Anneal
HOLD CYCLE HOLD HOLD
95°C 94°C 59°C 60°C 4°C
11 min 20 sec 3 min 10 min ¥

IMPORTANT! The NGM™ kit is validated for use at both 29 and 30 cycles. The
optimum conditions for the NGM™ kit are 29 cycles of amplification with a 1
ng input DNA concentration. Laboratories choosing to use the NGM™ kit at 30
cycles should reduce the input DNA concentration to 500 pg. Internal validation
studies to evaluate all aspects of kit performance are required for each
individual cycle number intended for operational use within the laboratory.

2. Load the plate or tubes into the thermal cycler and close the heated cover.

IMPORTANT! Ifusing adhesive clear film instead of caps to seal the plate wells,
be sure to place a MicroAmp® compression pad (Part no. 4312639) on top of the
plate to prevent evaporation during thermal cycling.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.
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Amplification using bloodstained FTA® cards

If you are storing the DNA... Then place at...
< 2 weeks 2t08°C
> 2 weeks -15to -25°C

IMPORTANT! Store the amplified products so that they are protected from light.

Amplification using bloodstained FTA® cards
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FTA® cards can be useful for the collection, storage, and processing of biological
samples. A small punch disc of the card containing the sample can be placed directly
into an amplification tube, purified, and amplified, without transferring the disc.
Applied Biosystems studies indicate that a 1.2-mm bloodstained disc contains
approximately 5-20 ng DNA. An appropriate cycle number for this high quantity of
DNA is 24 cycles, determined by Applied Biosystems validation studies. However, it
is recommended that each laboratory determine the optimum cycle number based on
internal validation studies.

In the example shown in Figure 4, a 1.2-mm disc of a bloodstained FTA® card was
purified using three washes with FTA® Purification Reagent and two washes with
1X low TE buffer. The punch was then amplified directly in the MicroAmp® tube for
24 cycles.

150 190 2 27 310 30

|

Figure 4 AmpF(STR® NGM™ PCR Amplification Kit results from a 1.2-mm FTA®
bloodstain disc (24-cycle amplification), analyzed on the Applied Biosystems
3130x/ Genetic Analyzer
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Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples. For samples run on the:

* Applied Biosystems 3500 Series Genetic Analyzers: Run at least one allelic
ladder per every set of 24 samples.
— Applied Biosystems 3500xL:
One ladder per injection
One injection = 24 samples (23 samples + 1 allelic ladder)
— Applied Biosystems 3500:
One ladder for every 3 injections
One injection = 8 samples
+ ABIPriSM® 3100 and Applied Biosystems 3130 Genetic Analyzers: Run at
least one allelic ladder per every set of 16 samples.
— Applied Biosystems 3130x1 or ABI PRISM® 3100 systems — One ladder per
injection; one injection = 16 samples (15 samples + 1 allelic ladder)
— Applied Biosystems 3130 or ABI PRISM® 3100-Avant — One ladder for
every 4 injections; one injection = 4 samples
+  ABI PRISM® 310 Genetic Analyzer: Run at least one allelic ladder for every 10
sample injections.

IMPORTANT! Variation in laboratory temperature can affect fragment
migration speed and result in sizing variation. Applied Biosystems recommends
the following frequency of allelic ladder injections; this frequency should
account for normal variation in run speed. However, during internal validation
studies, verify the required allelic ladder injection frequency to ensure accurate
genotyping of all samples in your laboratory environment.

When genotyping, it is critical to use an allelic ladder run under the same conditions
as the samples because:

» Size values obtained for the same sample can differ between instrument
platforms because of different polymer matrices and electrophoretic conditions.

* Variation in laboratory temperature can affect migration speed (see
IMPORTANT above). These variations can result in sizing variations between
both single and multiple capillary runs, with a greater size variation between
those samples injected in multiple capillary runs, than between those samples
injected in a single capillary run.

34 AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



Section 3.1 Electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x/
instruments

Set up the 3100/3100-Avant or 3130/3130x/ instrument for
electrophoresis

Reagents and Appendix B, “Ordering Information” on page 89 lists the required materials not
parts supplied with the AmpF(STR® NGM™ PCR Amplification Kit.
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IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF(STR® NGM™ Primer Set from light when not in use. Amplified
DNA, AmpF(STR® NGM™ Allelic Ladder, and GeneScan™ 500 LIZ® Size
Standard should also be protected from light. Keep freeze-thaw cycles to a minimum.

3100/3100-Avant The following table lists Data Collection Software and the run modules that can be
or 3130/3130x/ used to analyze AmpF(STR® NGM™ Kit PCR products. For details on the
instrument  procedures, refer to the documents listed in the table.
requirements

Data Operating
Collection Run modules and conditions References
System
Software

3.0% Windows e HIDFragmentAnalysis36_POP4_1 Applied Biosystems 3130/3130xI Genetic
(3130/3130x/ = XP Injection conditions: Analyzers Using Data Collection Software
Analyzer) v3.0, Protocols for Processing AmpF&STR

— 3130 =3 KV/5 sec PCR Amplification Kit PCR Products User

— 3130x/ = 3 kV/10 sec Bulletin (Part no. 4363787)

¢ Dye Set G5
20 Windows ¢ HIDFragmentAnalysis36_POP4_1 ABI PrisM® 3100/3100-Avant Genetic
(3100 2000 Injection condition: 3kV/10 sec Analyzers Using Data Collection Software
Analyzer) e Dve Set G v2.0, Protocols for Processing AmpF&STR
ye Set G5 PCR Ampilification Kit PCR Products User
Bulletin (Part no. 4350218)
1.1 Windows ¢ GeneScan36vb_DyeSetG5Module = ABI PrisM® 3100/3100-Avant Genetic
(3100 NT® Injection condition: 3kV/10 sec Analyzers Protocols for Processing
Analyzer) o GS500Analvsi AmpF&TR PCR Ampilification Kit PCR
nalysis.gsp Products User Bulletin (Part no. 4332345)
1.0 Windows ¢ GeneScan36Avb_DyeSetG5Module = ABI PRISM® 3100/3100-Avant Genetic
(3100-Avant | NT® Injection condition: 3 kV/ 5sec Analyzers Protocols for Processing
Analyzer) e GS500Analvsi AmpF&TR PCR Amplification Kit PCR
500Analysis.gsp Products User Bulletin (Part no. 4332345)

1 Applied Biosystems conducted validation studies for the AmpF(STR® NGM™ Kit using this configuration.
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Prepare samples for electrophoresis on the 3100/3100-
Avant or 3130/3130x/ instrument

Prepare the samples for electrophoresis on the 3100/3100-Avant or 3130/3130x/
instrument immediately before loading.

1.

10.

Calculate the volume of Hi-Di"" Formamide and GeneScan™ 500 LIZ® Internal
Size Standard needed to prepare the samples, using the table below.

Reagent Volume per reaction (pL)
GeneScan™ 500 LIZ® Size Standard 0.5 L
Hi-Di Formamide 9.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results/experiments.

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:
a. 10 uL of the formamide: size standard mixture

b. 1 uL of PCR product or allelic ladder

Note: For blank wells, add 11 uL of Hi-Di™ Formamide.

Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Prepare the plate assembly, then place onto the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.

36
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Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and

3500 instrument
requirements

parts

Appendix B, “Ordering Information” on page 89 lists the required materials not
supplied with the AmpF(STR® NGM™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF{STR® NGM™ Primer Set from light when not in use. Amplified
DNA, AmpF(STR® NGM™ Allelic Ladder, and GeneScan™ 500 LIZ® Size
Standard v2.0 should also be protected from light. Keep freeze-thaw cycles to a
minimum.

The following table lists Data Collection Software and the run modules that can be
used to analyze AmpF(STR® NGM™ Kit PCR products. For details on the
procedures, refer to the documents listed in the table.

Data

Genetic Collection Operating Run modules and conditions References
Analyzer System
Software
Applied 3500 Data | Windows® HID36_POP4 Applied Biosystems
Biosystems = Collection | XP Injection conditions: 1.2kV/15 sec 3500/3500xL Genetic Analyzer
3500 Software User Guide (Part no. 4401661)
v1.0 or Dye Set G5 ]
. Wind 3500 and 3500xL Genetic
Applied Vig’:a ows HID36_POP4 Analyzers Quick Reference
Blgg)(/)%telrﬁs Injection conditions: 1.2kV/24 sec = Card (Part no. 4401662)
X

Dye Set G5
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Section 3.2 Electrophoresis

Prepare samples for electrophoresis on the 3500/3500xL

instrument

Prepare the samples for capillary electrophoresis on the 3500/3500xL instrument
immediately before loading.

1.

Calculate the volume of Hi-Di"™" Formamide and GeneScan™ 500 LIZ® Size
Standard needed to prepare the samples, using the table below.

Reagent Volume per reaction (uL)

GeneScan™ 500 LIZ® Size Standard 0.5 L
Hi-Di™ Formamide 9.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

. Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each
MicroAmp® optical strip tube, add:

a. 10 puL of the formamide: size standard mixture

b. 1 uL of PCR product or allelic ladder

Note: For blank wells, add 11 puL of Hi-Di"" Formamide.

Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge
to ensure that the contents of each well are collected at the bottom.

Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.

Prepare the plate assembly, then put it onto the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

38
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Prepare samples for electrophoresis on the 3500/3500xL instrument

10. Start the electrophoresis run.
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Section 3.3 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and

310 instrument
requirements

Appendix B, “Ordering Information” on page 89 lists the required materials not

parts supplied with the AmpF{STR® NGM™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF{STR® NGM™ Primer Set from light when not in use. Amplified
DNA, AmpF(STR® NGM™ Allelic Ladder, and GeneScan™ 500 LIZ® Size
Standard should also be protected from light. Keep freeze-thaw cycles to a minimum.

The following table lists Data Collection Software and the run modules that can be
used to analyze AmpF(STR® NGM™ Kit PCR products. For details on the

procedures, refer to the documents listed in the table.

Data

Collection Oé) e;f:mg Run modules and conditions References
Software 4
3.1% Windows XP | ¢ GS STR POP4 (1mL) G5 ABI PRIsM® 310 Genetic Analyzer User’s Manual
or or v2.md5 (Windows) (Part no. 4317588)
3.0t Windows Injection condition: ABI PRIsM® 310 Protocols for Processing
NT® and 15 kV/5 sec AmpF&STR PCR Amplification Kit Products with
Windows Microsoft Windows NT Operating System: User
2000 Bulletin (Part no. 4341742)

1 Applied Biosystems conducted concordance studies for the AmpF(STR® NGM™ Kit using this configuration.
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Section 3.3 Electrophoresis

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for capillary electrophoresis on the 310 instrument immediately
before loading.

L.

10.

Calculate the volume of Hi-Di™ Formamide and GeneScan™ 500 LIZ® Internal
Size Standard needed to prepare the samples, using the table below.

Reagent Volume per reaction (uL)
GeneScan™ 500 LIZ® Size Standard 0.75 L
Hi-Di Formamide 24.25 pL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into each 0.2-mL or 0.5-mL sample tube, add:
a. 25 uL of the formamide: size standard mixture

b. 1.5 uL of PCR product or allelic ladder

Note: For blank wells, add 25 uL of Hi-Di"" Formamide.

Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95°C.
Immediately place the tubes on ice for 3 minutes.

Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

Start the electrophoresis run.

42
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Chapter 4 Data Analysis

GeneMapper® ID Software

Before you start  GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis. After electrophoresis, the Data
Collection Software stores information for each sample in an .fsa file. Using
GeneMapper® ID Software v3.2.1 software, you can then analyze and interpret the
data from the .fsa files.

Note: Refer to “Instrument and software overview” on page 15 for a list of
compatible instruments.
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When using GeneMapper® ID Software v3.2.1 to perform human identification
(HID) analysis with AmpF(STR® kits, be aware that:

» HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided that you
conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

» Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

» Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the +£0.5-nt bin window of any known allelic ladder
allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.

If you are using the GeneMapper® ID-X Software to perform Human Identification
(HID) analysis with AmpF{STR kits, go to “Set up GeneMapper® ID-X Software for
data analysis” on page 64 or refer to the GeneMapper® ID-X Software Version 1.0
Human Identification Analysis Getting Started Guide (Part no. 4375574).
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GeneMapper® ID Software

Setup Workflow

SG:;t’v?/gZﬁg ?rjaltg ;l;;)n Zr‘lalyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for the first
analysis )

» Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 49.

* Create an analysis method, as explained in “Create a HID analysis method” on
page 52.

* Create a size standard, as explained in “Create a HID size standard” on page 58.

* Define custom views of analysis tables.
Refer to the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Part no. 4335523) for more information.

* Define custom views of plots.

Refer to the GeneMapper® ID Sofiware Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Part no. 4335523) for more information.
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Import panels and bins

To import the AmpF(STR® NGM™ Kit panel and bin set from the
Applied Biosystems web site into the GeneMapper® ID Software v3.2.1 database:

1. Download and open the file containing panels and bins:

a. From the Support menu of www.appliedbiosystems.com, select
Support » Software Downloads, Patches & Updates » GeneMapper®
ID Software v 3.2 » Updates & Patches, and download the file NGM
Analysis Files GMID.

b. Unzip the file.

2. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (Part no. 4338775).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

[#.Panel Manager
File Edit Bins ‘fiew

= N R

== Panel Manager

Highlight this

b. Select File » Import Panels to open the Import Panels dialog box.
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Chapter 4 Data Analysis

c. Navigate to, then open the NGM Analysis Files GMID folder that you
unzipped in step 1 on page 49.

5. Select NGM_panel_v2, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager, AmpFLSTR_NGM_v2. This folder contains the panel and
associated markers.

E;;Impurl: Panels x|

Lookin: | NGM Analysis Files GMD =1 £

File name: INGMJ::anEI_VE.txt Impiort

iy Documerts SRS of type: I'ﬂ‘" Files LI Cancel

6. Import NGM_bins_v2:
a. Select the AmpFLSTR_NGM_v2 folder in the navigation pane.

(¥ Panel Manager
Fil= Edit Bins Wiew

Clorrorierit

[EHE=3Panel Manager Panel Hame
] ampFLSTR_Panels_v1 1 JNGM_panel_vz2 J

B ApFLSTR_MGM w2

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the NGM Analysis Files GMID folder.
d. Select NGM_bins_v2, then click Import.

Note: Importing this file associates the bin set with the panels in the
NGM_panel_v2 folder.
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GeneMapper® ID Software

_pangl_v2 b , Highlight this

File name: INGM_bins_vE.txt Irmpart
Files of type: |l Files ~|  cance

7. View the imported panels in the navigation pane:

a. Double-click the AmpFLSTR_NGM_yv2 folder to view the
NGM_panel_v2 folder.

b. Double-click the NGM_panel_v2 folder to display the panel information

in the right pane.
x|
File Edit Bins “igw
wk X || W ||=|l||amsazlmem_mns_vz ML ERNOOOoo0
E-=IPanel Manager Marker Hame  |Dye Color | Min Sive | Mac Sise | Cortrol Alleles Mirker F | Mfirker § | Commens Ladder illeles
[ ampFLSTR_Panels_vi 1 stz e 72.0 1270 [Mza5 4 01289 [nane §,3,10,11,12,1314 151617
EHES AmpFLETR_NGM_v2 2 v, blue 1490 2143 |"14,16" 4 0.1182 nane 11,12,13,14,15,16,17,18,19,
= D1DS1248 5 |C1Es539 blue 2236|2776 |90 4 04057 [nane 5891011 12,13,1415
L 4 |D2st3ss blue 2816|3560 |20.23" 4 0.1355 [nane 15,16,17,18,19,20,21 22 23,
0165539 5 |aMEL green 1000 [1080 "y g 00 |nane ®Y
—D21338 g |DE%1179 green 1179|1743 |23 4 01082 \none §9,10,11,12,13,14 151617
:2:;"1 7 7 |p21s11 green 1786  |2498  |"28,31" 4 0114 |nane 2424 2 25 26,27 26,26.2,29
L D211 g |C18351 green 2595|3475 (M215 4 0.1389 [nane 7910,10241,12,1313.2,1¢
018551 9 |Dz2siods yellow  |76.0 1200 ™18 3 0.1799 |nane 8,010,11,1213,14151617
[ D22E045 10 |D195453 yellow [1223 1663 |"14,15" 4 01105 |hone 310,11,1212.2,13,13.2,14,
:?;318433 11 |THO1 yellow 1764  [2211 ['7a3 4 0.0526 [none 4567,892310,11,15.3
L Foa 12 FGA yellow 2216 [3720  |"24,26" 4 04261 [nane 1716,19,20,21 22,23,24 25,
— D2s44 13 |D2sd41 red 745 134 |"415" 4 0.0947 [nane 9,10,11,11.3,12,13,1415,16
[ D331358 14 |D351358 red 1144 1624  |"1516" 4 01377 none 124314151617 18,19
:312;2:15 15 |C1S1656 red 1700|2240 316" 4 01416 |nane 9,10,11,12,13,14,14.315,15
16 |D12539 red 2250 [2870  [wEq90 4 0.1584 |nane 141516,17,16,19,19.3,20,2
—=IReference Samples

8. Select D10S1248 to display the Bin view for the marker in the right pane.
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f_‘_-‘l_':!PaneI Manager =
File Edit Bins \iew
X || || ||||m1 | |gin set: fuom_oins_v2 ~ 1| W= | [ [ [ [ o]
[EHEJPanel Manager
T &mpFLSTR _Panets_v1
S AmpFLSTR_HGM 2 10 7 3 a 10 11 12 13 14 15 16 17 18 19 20
E—ENGMJJaneI_ﬁ
01051248
[ 09
— [ME5539
— 0251338
— &MEL 0a
—DEs1179 :
— 021511
— D5s51
—D2251045 07
— 195433
— THM
—FGa, 06
— 025441
— D351358
— [MS1636 as
— 125391
—=JReference Samples 04
0.3
oz
01
oo
E7 71 75 74 83 a7 a1 93 99 103 107 111 1135 1149 123 127 131
01051243
Kl |’i
OK | Cancel | Apply |

9. Click Apply, then OK to add the AmpF(STR® NGM™ Kit panel and bin set to
the GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels
and bins are not imported into the GeneMapper® ID Software database.

Create a HID analysis method

The HID Advanced analysis method for the AmpF(STR® NGM™ Kit uses the
NGM_bins_v?2 file described in step 6 on page 50.

Use the following procedure to create a HID analysis method for the AmpFISTR®
NGM™ Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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E;;EeneMapper Manager |
Projects  Analysis Methods | Table Seftings | Plot Seﬁingsl Mairic:esl Size Standards
Marne Last Saved Ovener Inztrument Analysiz Type Descrip
HID_&dvanced 2009-06-15 16:22:2 | grnid HID =
HID_Classic 2007-08-06 10:03:0 | grnid HID
Microzstelite Default 2004-05-28 11:34:3 | gmid Microzatellite Factory _

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.
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3. Select HID and click OK to open the Analysis Method Editor with the General
Tab selected.

4. The figures below show the settings for each tab of the Analysis Method Editor.
Configure settings as shown unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings (See
step 5 on page 58). To complete this step quickly, do not save the analysis
method until you finish entering settings in all of the tabs.
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* General tab settings

Analysis Method Editor - HID =

General | lele | Pesk Detector | Peak Qualty | Gualty Flags |

&nalysis Method Description

[Marne: MGM_AnalysisMethod_v2

Description:

L LIv |

Instrument: I

Analysis Type: HID

OK | Cancel |

In the Name field, either type the name as shown for consistency with files
supplied with other AmpF(STR® kits, or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your
software configuration from the drop-down list. The Description and
Instrument fields are optional.
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+ Allele tab settings

Analysis Method Editor - HID x|

General Allele I Pesk Detectc-rl Pesk Qualityl Quiality Flagsl

B Set:
v Use marker-specific stutter ratio it available
Marker Repest Type Tri Tetra Perta Hexa [®)
Cut-off Yalue joo joo joo jo.0 g
Mirus.2, Retia joo joo joo jo.0 <
MinuzA Distance From  |0.0 0.0 0.0 0.0 §
Ta oo 0.0 0.0 0.0 %
Mitwis: Stutter Ratio jno jno jno jno &
Minus Stutter Distance  From  [2.25 [3.25 joo joo »
To |375 Ja7s joo joo g‘c
Plus Stutter Ratio 0.071 0o 0o 0o )
Pluz Stutter Distance From |2.25 0.0 0.0 0.0 @
To 375 jno jno jno
Amelogenin Cutoff IF

Range Fitter .. | Factary Defaults |

CK | Cancel |

— In the Bin Set field, select the NGM_bins_v2 bin set imported
previously and configure the stutter distance parameters as shown.

— GeneMapper® ID Software v3.2.1 allows you to specify four types of
marker repeat motifs: tri, tetra, penta, and hexa. You can enter
parameter values for each type of repeat in the appropriate column.

— The “Use marker-specific stutter ratio if available” check box is
selected by default. Consequently, the software applies the stutter ratio
filters supplied in the NGM_panel_v2 file. GeneMapper ID Software
v3.2.1 specifies locus-specific filter ratios for minus stutters, but not
for plus stutters, in the panel file. However, validation studies with the
NGM™ kit show that the trinucleotide repeat D22S1045 locus
produces a relatively large amount of plus stutter compared to
tetranucleotide repeat loci. The relatively large amount of stutter may
cause the stutter peak to be labeled during routine analysis.

— The plus stutter at the D22S1045 locus can be filtered by assigning a
global plus stutter filter for trinucleotide repeat loci in the Analysis
Parameter file. Because D22S1045 is the only trinucleotide repeat
locus in the NGM™ kit, this stutter filter setting is applied only to
plus stutter peaks at the D22S1045 locus. The settings shown above
resulted in little or no labeling of D22S1045 plus stutter peaks during
validation studies at Applied Biosystems. However, we recommend
that users determine the settings appropriate for use in their laboratory
during internal validation studies.
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Peak Detector tab settings

Analysis Method Editor - HID x|

General I Allgle  Peak Detector I Peak Quslity I Quiality Flags I

Peak Cetection Algorithm: IAdvanced it I

Ranges Peak Detection
Arialysis Sizing Peak Amrpltude Thresholds:
Full Range LI IAII Sizes LI B: I TBD R I TED
Start Pt |0 Start Size0

e _ & | TBD o] TBD
Stop P 10000 Stop Size: 1000

Y: I TBD

—Smoothing and Baselining
Min. Pesk Half tyicth: |2 pts
Smoathing ™ Nohe I_
i ¥ 3
o Lt Polyromial Degree:
" Heawy Peak Window Size: |1 5 pts
Baseling Windowe: |51 pts Slope Threshald
Peak Start: ID.EI
~Size Calling Method Peak Enct I_D.EI

" 2nd Order Lesst Sguares
(ol
' Cukic Spline Interpolation
" Locsl Southern Method
" Global Southern Method

Factary Defautts |

CK | Cancel |

IMPORTANT! To be determined (TBD) indicates values to be determined
in your laboratory. Laboratories must perform the appropriate internal
studies to determine the peak amplitude thresholds for interpretation of
NGM™ kit data.

Fields include:

— Peak amplitude thresholds — The software uses these parameters to
specify the minimum peak height, in order to limit the number of
detected peaks. Although GeneMapper® ID Software displays peaks
that fall below the specified amplitude in electropherograms, the
software does not label or determine the genotype of these peaks.

— Size calling method — The NGM™ kit has been validated using the 3™
Order Least Squares sizing method in combination with the
GeneScan'"-500 LIZ® size standard. Alternative sizing methods
should be selected only after extensive evaluation as part of an internal
validation study in the user’s laboratory.
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* Peak Quality tab settings

Analysis Method Editor - HID x|

General | Allele | Pesk Detector  Peak Gusity | quaity Flags |

—=ignal level
Homozygous min peak height I TBD
Heterozygous min peak height I TBD
o ©
Heterozygate balance @
>
Min peak height ratio ID.? %
)
~Peak morphology g
(0]
Max peak width (hasepairs) |1 5 )
S
—Pull-up peak (%)
Pull-up ratio 0.05 ,%
s
)
(0}

~A&llele number

Max expected aleles |2

Factary Defaulis |

Ok | Cancel |

IMPORTANT! To be determined (TBD) indicates values to be determined
in your laboratory. Laboratories need to perform the appropriate internal
validation studies to determine the minimum heterozygous and
homozygous minimum peak height thresholds and the minimum peak
height ratio threshold that allow for reliable interpretation of AmpF(STR®
NGM™ Kit data.
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* Quality Flags tab settings

Analysis Method Editor - HID |

General | Allele | Pesk Detector | Peak Quaity Quality Fiags |

Quality weights are between 0 and 1.
—Euality Flag Settings

Spectral Pull-up IF Control Concordance IT
Broad Peak IF Lowy Peak Height I?
Ot of Bin Allele IF Off-zcale IF
Ty s Pesk Height Ratio [

rPay Threshalds
Pazs Range: Loy Guality Range:
Sizing Guality; From ID.?S to1.0 From 0.0 {0 ID.25
Genotype Quality: Fram |0.75 to1.0 Fraom O.0to (025

Factary Defaultts |

Ok | Cancel |

IMPORTANT! The values shown are the software defaults and are the
values used by Applied Biosystems during developmental validation.
Laboratories must perform appropriate internal validation studies to
determine the appropriate values to use.

5. Click Save.

Create a HID size standard

The size standard for the AmpF(STR® NGM™ PCR Amplification Kit uses the
following GeneScan™ 500 LIZ® Size Standard peaks in its sizing algorithm: 75,
100, 139, 150, 160, 200, 300, 350, 400, and 450.
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Use the following procedure to create the size standard for the AmpF(STR® NGM™
Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

[@)GeneMapper Manager x|
Projects | Analysis Methods | Table Settings | Plot Setings | Matrices i
|Name |Las1 Saved |Owner |T\,r'pe |Descrip‘finn
377 _F_HID_GS500 2004-05-28 11:34: 3 | grnic BasiciAdvanced Factory Provided  |=
CE_G5_HID_G=500 2004-05-28 11:34: 3 | grnic BasiciAdvanced Factory Provided
CE_F_HID_G=:500 2004-05-28 11:34: 3 | grnic BasiciAdvanced Factaory Provided |

1= DREm... Save L. Ibpart. Export... Lelete |
Done |
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2. Select the Size Standards tab, then click New.

3. Complete the Name field as shown below or with a name of your choosing. In
the Size Standard Dye field, select Orange. In the Size Standard Table, enter the
sizes specified in “Create a HID size standard” on page 58.

E; Size Standard Editor x|
Edit
—Size Standard Description
Marme: CE_G5_MGM_GS500
Description:
Size Standard Dye: IOrange j
~Size Standard Table
Size in Basepairs
1 Fso |
2 1000
3 1390
4 1500
5 1600
5 |2000
7 |3000
g |3500
g (4000
10 (4500

QK | Cancel |

Analyze and edit Analyze a project

sample files with
GeneMapper® ID 1. In the Project window, select File » Add Samples to Project, then navigate to

Software the disk or directory containing the sample files.
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2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the name you specified.

Parameter Settings
Sample Type Select the sample type.
Analysis Method NGM_AnalysisMethod_v2
Panel NGM_panel_v2
Size Standard CE_G5_NGM_GS500

Size Standard: For more information about how the Size Caller works,
refer to the ABI Prism® GeneScan® Analysis Software for the Windows
NT® Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (Part no. 4335617).

CE_G5_NGM_GS500 (size standard fragments defined in the
AmpF(STR® NGM™ Kit): 75, 100, 139, 150, 160, 200, 300, 350, 400, and
450. For additional information about size standards, refer to the
GeneMapper® ID Software Version 3.1 Human Identification Analysis
User Guide (Part no. 4338775).

CE_G5_NGM_GS500: Neither the 250-nt nor the 340-nt peak is included
in the size standard definition. These peaks can be used as an indicator of
precision within a run.

3. Click I (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

The status bar displays the progress of analysis as both:
— A completion bar extending to the right with the percentage
completed indicated

— With text messages on the left

The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

The Genotypes tab becomes available after analysis.

60

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



For more information

E"Genel“lapper ID ¥3.2.1 - NGM Population Data - gmid Is Logged In A8 -|Of x|

Fle Edit Analysis Wiew Tools Help

e = BB e || Wl L[ A B | e @ || e seting| | o Tabe ~lE | B&| s

E-=IProject Samples I Genmypegl

m 2009-01-20 Status | Sample File Satple Natne Sample Type | Analysis Method Panel Size Standard Fun Natme Instrument Type
1 [ |Cersbus 012009 [IE_0001 Sample NGM_Analysishethad_v2 | NGM_panel_v2 CE_G5_MGM_GSS00 | 2008-01 -20_C| ABI31 30 |
2 v |Cerebus_012009 [IE_0002 Sample MG _Analysishethod_v2  |NGM_panel w2 CE_GS5_MGM_GSS00  |2009-01-20_C| 2813130
3 [ |Cerebus 012008 [IB_0003 Sample G _Analysishethod_v2  |[NGh_panel w2 CE_G5_NGM_GSS00 | 2008-01-20_C | 28131 30
4 |3 Cerebus_012003 |IE_0004 Sample MG _AnalysisMethod_v2  |NGM_panel_v2 CE_GS_MGM_GS500 | 2009-01-20_C| ABI31 30 |
5 h Cerebus_012008 |IB_0005 Sample MGM_AnalysisMethod_v2  |NGM_panel_v2 CE_GS_MGM_GS500 | 2009-01-20_C| ABI3130 |
G [ |Cersbus_012008 [IB_000E Sample NGM_Analysishethad_v2 | NGM_panel_v2 CE_G5_MGM_GSS00 | 2008-01 -20_C| ABI31 30 | [0)
7 v |Cerebus_012009 [IB_0007 Sample MG _Analysishethod_v2  |NGM_panel w2 CE_GS5_MGM_GSS00  |2009-01-20_C| 2813130 %
3 [ |Cerebus 012008 [IB_0008 Sample G _Analysishethod_v2  |[NGh_panel w2 CE_G5_NGM_GSS00 | 2008-01-20_C | 28131 30 %
9 |3 Cerebus_012003 |IE_0003 Sample MG _AnalysisMethod_v2  |NGM_panel_v2 CE_GS_MGM_GS500 | 2009-01-20_C| ABI31 30 | [
10 h Cergbus_012008 |IB_0010 Sample MGM_AnalysisMethod_v2  |NGM_panel_v2 CE_GS_MGM_GS500 | 2009-01-20_C| ABI3130 | %
11 b= |Cersbus 012009 [IB_0011 Sample NGM_Analysishethad_v2 | NGM_panel_v2 CE_G5_MGM_GSS00 | 2008-01-20_C | &B131 30 | @
12 [ |Cersbus 012009 [IB_0012 Sample MG _Analysishethod_v2  [NGM_panel w2 CE_GS5_MGM_GSS00  |2009-01-20_C|~B131 30 | \@
13 [ |Cerebus 012008 [IB_0013 Sample G _Analysishethod_v2  |[NGh_panel w2 CE_GS_NGM_GSS00 | 2009-01-20_C | £E13130 O
14 |3 Cerebus_012003 |IE6_0014 Sample MG _AnalysisMethod_v2  |NGM_panel_v2 CE_GS_MGM_GS500 | 2009-01-20_C| ABI31 30 | CO/J
15 h Cerebus_012009 |Ladder1 Allelic Ladder  [MNGM_AnalysisMethod_v2  |NGM_panel_v2 CE_GS_MGM_GS500 | 2009-01-20_C| ABI3130 | =+
] | | 5
|« | [ @
Progress Status ... | B

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:

»  GeneMapper® ID Sofiware Versions 3.1 and 3.2 Human Identification Analysis
Tutorial (Part no. 4335523)

s GeneMapper® ID Sofiware Version 3.1 Human Identification Analysis User
Guide (Part no. 4338775)

s Installation Procedures and New Features for GeneMapper® ID Software
Version v3.2 User Bulletin (Part no. 4352543)
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Section 4.1 GeneMapper® ID-X Software

Before you start

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis. After electrophoresis, the Data
Collection Software stores information for each sample in an .fsa file (for 310 and
31xx CE instruments) or an .hid file (for 3500 and 3500xL instruments). Files in .fsa
format can be analyzed by any version of GeneMapper /D-X software (that is v1.0 or
higher); .hid files can only be analyzed by GeneMapper /D-X v1.2 or higher.

Note: Refer to “Instrument and software overview” on page 15 for a list of
compatible instruments.

When using GeneMapper® ID-X Software v1.0.1 or higher to perform human
identification (HID) analysis with AmpF{STR® kits, be aware that:

* HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided that you
conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

» Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

» Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

+ Alleles that are not in the AmpF{STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the +0.5-nt bin window of any known allelic ladder
allele or virtual bin.
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Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Workflow To analyze sample (.fsa) files using GeneMapper® ID-X Software v1.0.1 or higher
for the first time:

Import panels, bins, and marker stutter into the Panel Manager, as explained in
“Import panels, bins, and marker stutter” on page 64.

Create an analysis method, as explained in “Create an analysis method” on
page 69.

Create a size standard, as explained in “Create a size standard” on page 74.
Define custom views of analysis tables.

Refer to the GeneMapper® ID-X Software Version 1.0 Getting Started Guide
(Part no. 4375574) for more information.

Define custom views of plots.

Refer to the GeneMapper® ID-X Software Version 1.0 Getting Started Guide
(Part no. 4375574) for more information.

Import To import the AmpF(STR® NGM™ Kit panels, bin sets, and marker stutter from the
panels, bins, and  Applied Biosystems web site into the GeneMapper® ID-X Software database:

marker stutter

1.

Download and open the file containing panels, bins, and marker stutter:

a. From the Support menu of www.appliedbiosystems.com, select
Support » Software Downloads, Patches & Updates » GeneMapper®
ID-X Software » Updates & Patches, and download the file NGM
Analysis Files GMIDX.

b. Unzip the file.

Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Part no. 4375574).

Select Tools » Panel Manager.

Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

»* Panel Manager

File Edit Bins Wiew Help

[ > atl ;I '-|

R . Panel Manager B Highlight this

b. Select File » Import Panels to open the Import Panels dialog box.

64

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide


http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
http://www.adobe.com
http://www.adobe.com
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com

Set up GeneMapper® ID-X Software for data analysis

c. Navigate to, then open the NGM Analysis Files GMIDX folder that you
unzipped in step 1 on page 64.

5. Select NGM_panel_v2X, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager “AmpFLSTR_NGM_v2X”. This folder contains the panel and
associated markers.

#* Import Panels er
Logkin: |() NGM Analysis Files GMIDK v 2 EE
T [Z] MGM_bins_vzx.bxt
4 B NGM_panel_w2X.txt
My Recent r:;] MGM_stutter _vZx.Exk
Documents
Desktop
o
My Documents | File name: |NG|\"|Jjane|_\|'2X.txt | [ Impart ]

g_l Files of type: |AII Files w | Cancel

6. Import NGM_bins_v2X:
a. Select the AmpFLSTR_NGM_v2X folder in the navigation pane.

#* Panel Manager

File Edit Bins Wiew Help

WX | E | W s v
=) sZxPanel Manager Panel Hime Comment

28 (W) AmpFLSTR_NGM_v2X 1 NGM_panel_vZx null

- [T AmpFLSTR_Panels_vix

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the NGM Analysis Files GMIDX folder.
d. Select NGM_bins_v2X, then click Import.

Note: Importing this file associates the bin set with the panels in the
NGM_panel_v2X folder.
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»* Import Bin Set

Look in: |&:| NGM Analysis Files GMIDX - | I I
Ty B NGM_b
i [Z] NGM_panel_vZ.bxk
My Recent =| MNGM_skukker v kxk
Documents
Desktop
hN
My Documents | TilE Dame: |NGM_bins_v2X.txt | [ Impaort ]
-Lj ™ Files of type: | All Files v | Cancel

7. View the imported panels in the navigation pane:

a. Double-click the AmpFLSTR_NGM_v2X folder to view the
NGM_panel_v2X folder.

b. Double-click the NGM_panel_v2X folder to display the panel information
in the right pane and the markers below it.

#* Panel Manager

File Edit Bins View Help

wi X | B M M ™ | oSt [No bins vax v MLEE EEEEEEN
B...ﬁ%bpand Managar Dlarkcer Hane Inpe Color |Mlin Sige | Blax Sime | Control Slleles Mlarkeer | Commrwrdes Ladder Alleles
9--&_)AmpFLSTR_NGM_\r2X 1 1051248 Blue 720 127.0 12,15 4 none 8,9,10,11,12,13,14,15,16,17,15
9" 2 (v Blue 149.0 [214.3 (14,16 4 none 11,12,13,14,15,16,17,18,19,20,21,22, 27
3 0165539 Blue 223.6 2776 9,10 4 none 5,8,9,10,11,12,15,14,15
4 [Dzs1338 Blue 281.6 |356.0 |20,23 4 none 15,16,17,18,19,20,21,22,23,24,25,26,27
5 |AMEL areen 100.0 105.0 A 9 nane EA
6 |DB51179 Green |117.9  [174.9  [1z,13 4 none 5,9,10,11,12,13,14,15,16,17,15,19
7 |b21sit Green 178.8 249.8 28,31 4 nane 24,24.2,25,26,27,28,28.2,29,29.2,30,30
§ |D18551 Green  |259.5  |M7.5 12,15 4 none 7,9,10,10,2,11,12,13,13.2,14,14.2,15, 1
9 |DE231045 ellow a0 1z20.0 11,16 3 none 8,9,10,11,12,13,14,15,16,17,15,19
10 0195433 Yellow 122.3 166.3 14,15 4 none 9,10,11,12,12,2,13,15.2,14,14.2,15,15..
11 |THO1 vellow [176.4 (2211 [7,9.3 4 none 4,5,6,7,8,9,9,3,10,11,13.3
12 |FaEd Yellow 2216 3720 24,26 4 none 17,18,19,20,21,22,23,24,25,26,26.2,27,
13 |D25441 Red 74.5 1134 14,15 4 none 9,10,11,11.3,12,13,14,15, 16
14 |D351358 Red 114.4 165.4 15,16 4 nane 12,13,14,15,16,17,18,19
F- D125391
& 2 AmpFLSTR, Panels_vix | |15 0151656 Red 1700 [zz40 (13,16 4 none 9,10,11,12,13,14,14.3,15,15.3,16,16.3,
16 |D125391 Red 225.0 287.0 15,19 4 nane 14,15,16,17,18,19,19.,3,20,21,22,23,24,
A--:&Reference Samples |

8. Select D10S1248 to display the Bin view for the marker in the right pane.
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File Edit Bins WView Help
] . | s = =y
B | (6 M| B LY | Ense: [Nomons vax v fLESE BEEEEEN o
B---%Panel Manager
E}--@nmpFLSTR_NGM_\rZX . 7 ] a 10 11 12 13 14 15 16 17 18 19 20
=-ICHNGM_panel_v2x
VWA 04
--D165539
- D251338 ns
-- AMEL
-- DEs1179
& D21511 o
[ D18551
- D2251045 0.6
--D195433
-- THO1
- FGA 0.5
-- D25441
- D351358 -
--D151656
(- D125391
- IC3) AmpFLSTR _Panels_v1x L
— 0.z
------ B Reference Samples
0.1
00
67 63 71 73 TS 77 73 @1 83 85 &7 83 91 8% 85 87 83 104 103 105 107 109 111 113 M5 17 119 121 123 125 127 129 13
01051243
< E3
[ QK H Cancel H Apply H Help ]

9. Import NGM_stutter_v2X:
a. Select the AmpFLSTR_NGM_v2X folder in the navigation panel.

#* Panel Manager

File Edit Bins Wiew Help

awi' > W E | W ™ | Binset: |NGM_bins_vzx v
=) sZxPanel Manager Panel Hime Comment
& AmpFLSTR_NGM 1 NGM_panel_vZx null

&[5 AMpFLSTR,_Panels_v1x

b. Select File » Import Marker Stutter to open the Import Marker Stutter
dialog box.

c. Navigate to, then open the NGM Analysis Files GMIDX folder.
d. Select NGM_stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the NGM_bins_v2X folder.
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X

#* Import Marker Stutter

Loak in: |E NGEM Analysis Files GMIDX v| I FF’1'|||E|
Ty [Z] MGM_bins_va.bxt
u‘b [Z] NGM_panel_vZtst
My Recent E MNGM_stutker w2 kxt
Documents
?L-':
Desktop

My Documents Filz pame: |NGM_stutter_u2X.txt | [ Impart ]

Cla Files of type: | All Files v| Cancel

10. View the imported marker stutters in the navigation pane:

a. Select the NGM_panel_v2X folder to display its list of markers in the
right pane.

b. Double-click the NGM_panel_v2X folder to display its list of markers
below it.

c. Double-click D22S1045 to display the Stutter Ratio & Distance view for
the marker in the right pane.

Because D22S1045 has a trinucleotide repeat unit, it produces a higher
level of plus stutter than tetranucleotide markers, and so requires the use of
a plus stutter filter. The settings for the D22S1045 plus stutter filter can be
seen in the table in the right pane. Other markers may not require a plus
stutter filter, in which case the settings for plus stutter are left blank.

#* Panel Manager _'4
File Edit Bins View Help
X | B E W | W™ | onse [navbins v JiLnEsE EEEEEEN | ¢
B---&Panel Manager ~ . . " .
53 AmpFLSTR_NGM_v2X — || Please enter the stutter filter(s) for D2251045 marker here If left blank, the global stutter filter will be applied.
E!---L":)NGMjanel_VZX
e Minus Stutter Plus Stutter
B VWA
[ D165539 Ratio From Distance To Distance Ratio From Distance To Distance
- D251338 1 1799 225 3.75 1 0710 2.25 3.75
B AMEL 5 =
- DB31179
- D21511 B o
- D18351 4 4
- D2251045 -
O .- R atio 5 Dist: ((tew J[ Ede |[ pelete ]
[ D195433

11. Click Apply, then OK to add the AmpF(STR® NGM™ Kit panels, bin sets, and
marker stutter to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter will not be imported into the GeneMapper®
ID-X Software database.
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Create an  Use the following procedure to create an analysis method for the AmpF(STR®
analysis method NGM™ Kit.

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with GeneMapper® ID-X Software
v1.0, v1.1 or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

#* GeneMapper® ID-X Manager

Find Name Containing:

Projects| Analysis Methods | Table Settings | Plok Settings | Matrices | Size Standards | Report Settings

Mame Last Saved Cner Instrument Analysis Type C
| AmpFLSTR_AnalysisMethod_wiy 2011-02-25 09:43:0 | gridx HID | £y
£ | >

New... Open Save As Export Delete

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

3. The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures
below, unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings (see
step 4 on page 74). To complete this step quickly, do not save the analysis
method until you finish entering settings in all of the tabs.

(@)
o
>
()
<
V)
e
ie]
Y
@
?
>
(2]
=4
—
=
()
=
()

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide 69



Section 4.1 Data Analysis

General tab settings

Analysis Method Editor

iGenerdl | Allele | Peak Detector || Peak Quaity | 50 & GQ Settings |
rAnalysis Method Description
Name: NGM_AnalysisMethod_v2
Security Group: GeneMapper ID-X Security Group v
Description: rY
w
Instrument:
Analysis Type: HID
[ Save As ] [ Save ] [ Cancel ] [ Help ]

In the Name field, either type the name as shown for consistency with files
supplied with other AmpF(STR® Kkits or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your
software configuration from the drop-down list. The Description and
Instrument fields are optional.
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+ Allele tab settings

Analysis Method Editor

| General | Allelz | Peak Detectar || Peak Quality || SQaGQ Settings|

Bin Set:
|Use marker-specific stutter ratio and distance if available

Marker Repeat Type: Tri Tekra Penka Hexa

Global Cut-off Value 0.0 0.0 0.0 0.0

MinusA Ratio 0.0 0.0 0.0 0.0

MinusA Distance From |0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0

Global Minus Stutker Ratio 0.0 0.0 0.0 0.0

Global Minus Stutker Distance  From 2,25 3.25 0.0 0.0
Ta |3.75 4.75 0.0 0.0

Glabal Plus Stutter Ratio 0.0 0.0 0.0 0.0

Glabal Plus Stutter Distance From 0.0 0.0 0.0 0.0
To |00 0.0 0.0 0.0

amelogenin Cutaff

Range Filcer. .. Eactory Defaults

[ Save As H Save H Cancel H Help ]

— In the Bin Set field, select the NGM_bins_v2X bin set imported
previously and configure the stutter distance parameters as shown.

— GeneMapper® ID-X Software allows you to specify 4 types of marker
repeat motifs: tri, tetra, penta and hexa. You can enter parameter
values for each type of repeat in the appropriate column.

— The “Use marker-specific stutter ratio if applicable” check box is
selected by default. When this box is checked, the software applies the
stutter ratio filters in the NGM_stutter_v2X file.
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Peak Detector tab settings

X

Analysis Method Editor

General | Allele | Peak Detector | Peak Quality | 5Q & GO Settings

Peak Detection Algorithm: Advanced

Ranges Peak Detection

Analysis Sizing Peak Amplitude Thresholds:
FEETEE v | | Al sizes v B:l TBD | o | TBD |
G| TBD | p: [ TBD |
v. | TBD | o:| TBD |

rSmoothing and Baselining

Min. Peak Half Width: |2 pts
Smoathing ) None
i £ 3
@ Light Palynomial Degree
O Heavy Peak Window Size: 15 pts
Baseline Window: pts Slope Threshald
Pesk Start: 0.0
~Size Calling Methad e 0.0
() 2nd Order Least Squares
(%) 3rd Order Least Squares e e

(") Cubic Spline Interpalation
(") Local Southern Method
() Global Southern Methad

[]use Normalization, if applicabls

Eactary Defaults

[ Save As H Save H Cancel H Help ]

IMPORTANT! To be determined (TBD) indicates values to be determined
in your laboratory. Laboratories must perform the appropriate internal
studies to determine the appropriate peak amplitude thresholds for
interpretation of AmpF(STR® NGM™ Kit data.

Fields include:

— Peak amplitude thresholds — The software uses these parameters to
specify the minimum peak height, in order to limit the number of
detected peaks. Although GeneMapper® ID-X Software displays
peaks that fall below the specified amplitude in electropherograms,
the software does not label or determine the genotype of these peaks.

— Size calling method — The NGM™ kit has been validated using the 3™
Order Least Squares sizing method in combination with the
GeneScan'"-500 LIZ® size standard. Alternative sizing methods
should be selected only after extensive evaluation as part of an internal
validation study in the user’s laboratory.
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— Normalization — a Normalization checkbox is available on this tab in
GeneMapper® ID-X Software v1.2 or higher for use in conjunction
with data run on the Applied Biosystems 3500 Series Genetic
Analyzers. Users of this version of software should perform
laboratory evaluations to determine whether to use the Normalization
feature for analysis of NGM™ kit data.

* Peak Quality tab settings

Analysis Method Editor

| General | Allele | Peak Detsctor | Paak Quality | S0 & G Settings |

Min/Max Peak Height (LPH/MPH)
Homazygous min peak height TBD

Heterozygaous min peak height TBD
B

—
o

Max Peak Height (MPH)

Peak Height Ratio (PHR)

o |

g ] -
5 n
w

B

w)

Min peak height ratio

Broad Peak (BD)
Max peak width (basepairs)

Allele Mumber (AN)

Max expected aleles

Allelic Ladder Spike

Spike Detection

=
]

Cut-off Value

Factary Defaults

’ Save As H Save H Cancel H Help ]

IMPORTANT! To be determined (TBD) indicates values to be determined
in your laboratory. Laboratories must perform the appropriate internal
validation studies to determine the minimum heterozygous and
homozygous minimum peak height thresholds, maximum peak height
threshold, and the minimum peak height ratio threshold for reliable
interpretation of AmpF(STR® NGM™ Kit data.
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+ SQ & GQ tab settings

Analysis Method Editor

General | Allele || Peak Detector | Peak Quality | 5Q & GQ Settings

Quality weights are between 0 and 1.
Sample and Control GQ Weighting

Broad Peak (BO) 0.8 Allele Mumber (AN) 1.0
Qut aof Bin Allele (BIM) 0.5 Low Peak Height (LPH) 0.3
Qverlap (OWL) 0.8 Max Peak Height (MPH) 0.3
Marker Spike (SPK) 0.3 OFf-scale (0S5) 0.8

Peal: Height R atio (PHR) 0.3

Contral Concordance (CC) Weight = 1.0 (Only applicable to controls)

SQ Weighting
Broad Peak (BD)

rAllelic Ladder GQ Weighting
Spike (S5PK/SPK) Off-scale (05)

S0 & GQ Ranges

Sizing Quality: From [0.75 ta 1.0 From Q.0 to

Genotype Quality:  From |0.75 ko 1.0 From 0.0 to
Reset Defaults

[ Save As ] [ Save ] [ Cancel ] [ Help ]

IMPORTANT! The values shown are the software defaults and are the
values used by Applied Biosystems during developmental validation.
Laboratories must perform appropriate internal validation studies to
determine the appropriate values to use.

4. Click Save.

Create a size  The size standard for the AmpF(STR® NGM™ PCR Amplification Kit uses the
standard following GeneScan™ 500 LIZ® Size Standard peaks in its sizing algorithm: 75,
100, 139, 150, 160, 200, 300, 350, 400, and 450.

Use the following procedure to create the size standard for the AmpF(STR® NGM™
Kit.

1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper® ID-X
Manager.
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2. Select the Size Standards tab, then click New.

»* GeneMapper® ID-X Manager

Find Name Containing: ‘ ‘

| Projects || Analysis Methods || Table Settings | Plot Settings | Matrices | Size Standards | Report Settings|

[Name |Last Saved |Owner Type |Descriptian
| CE_F_HID_GS500 (75-400) Z007-05-09 13:23:5 | qmidx Advanced ~
| CE_F_HID_GS500 (75-4500) Z007-08-09 13240 | qmids Advanced
| CE_G5_HID_GS500 Z006-10-11 13:12:% | qmidx Advanced -

=

3. Complete the Name field as shown below or with a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software
configuration from the drop-down list. In the Size Standard Dye field, select
Orange. In the Size Standard Table, enter the sizes specified in “Create a size
standard” on page 74.

ot Size Standard Editor

Edit

rSize Standard Descripkion

MName: CE_G5_MGM_GS500

Security Group: GeneMapper ID-X Security Group
Description:

Size Standard Dye: | Orange w |

rSize Standard Table

Size in Basepairs

W | [ nsert || Delete |

2 |100.0

3 |139.0

4 |150.0

5 |160.0

& |200.0

7 |300.0

g |350.0

9 |400.0
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’ oK ” Cancel ” Help ]
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Analyze and edit sample files with GeneMapper® ID-X

Software

Analyze a project 1. In the Project window, select File » Add Samples to Project, then navigate to
the disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the name you specified.

Parameter Settings
Sample Type Select the sample type.
Analysis Method NGM_AnalysisMethod_v2X
Panel NGM_panel_v2X
Size Standard CE_G5_NGM_GS500

Size Standard: For more information about how the Size Caller works,
refer to the ABI PRISM® GeneScan® Analysis Software for the Windows
NT® Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (Part no. 4335617).

CE_G5_NGM_GS500 (size standard fragments defined in the
AmpF(STR® NGM™ Kit): 75, 100, 139, 150, 160, 200, 300, 350, 400, and
450. For additional information about size standards, refer to the
GeneMapper® ID Software Version 3.1 Human Identification Analysis
User Guide (Part no. 4338775).

CE_G5_NGM_GS500: Neither the 250-nt nor the 340-nt peak is included
in the size standard definition. These peaks can be used as an indicator of
precision within a run.

3. Click I* (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage completed indicated.

The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).
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* The Analysis Summary tab is displayed upon completion of the analysis.
The figure below shows the analysis summary window after analysis.

»* GeneMapper® ID-X - NGM Analysis Example - gmidx Is Logged In Database FOSGREENRXL04
File Edit Analysis View Tools Admin Help

E; (] m @ E] 1 [ 3 " Table Setting: 3130 Data Analysis v | p & (& B (7]
=) gy Project Samples | Analysis Summary | Genokypes
=-2110217_Mul ‘ ‘
Analysis Summary Summary Generation Date: Feb 25, 2011 10:33:37 AM
Select run Folder to display:
Sample Status [ Total # of Samples ]
% Unanalyzed 0
Analyzed 18
lgj Analysis Setting Changed 1]
Click a link below to display a filtered Samples Takle containing only the samples selected
Allelic Ladder Quality per run folder (based on $Q and CGQ only)
Run Falder ][ Tokal # of Analyzed Ladders ][ ][ i ][ r]
110217_Muligan_Ref_Plat=19_3130xl... | 2 | 2 | o | o |
Control Quality per project (hased on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)
Control Type Toktal # of Samples [ All thresholds met [ O One or mare thresholds not mek
Positive Contral 0 0 0
Custom Cantrol 0 0 1]
Megative Contral 0 0 ]
Tokal 0 0 Q
Sample Quality per project (based on sample PQVs: S0S, SSPK, MIX, OMR, SQ, CGQ)
|[ ][ Tokal # of Samples ][ All thresholds met ][ O One or more thresholds not met ]
|Samplzs | 16 | 5 11 |
< | 3
Analysis Completed. I Stap ‘

Examine and edit You can display electropherogram plots from the Samples and Genotypes tabs of the
a project Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).

For more information

+ For quick set-up instructions, refer to the GeneMapper® ID-X Sofiware Version
1.0 Getting Started Guide (Part no. 4375574).
+ For details about GeneMapper® ID-X Software features, allele filters, peak
detection algorithms, and project editing, refer to:
—  GeneMapper® ID-X Sofiware Version 1.0 Getting Started Guide (Part
no. 4375574)
—  GeneMapper® ID-X Sofiware Version 1.0 Quick Reference Guide (Part
no. 4375670)
—  GeneMapper® ID-X Sofiware Version 1.0 Reference Guide (Part
no. 4375671)
—  GeneMapper® ID-X Sofiware Version 1.1 (Mixture Analysis Tool) Getting
Started Guide (Part no. 4396773)
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Section 4.1 Data Analysis

—  GeneMapper® ID-X Sofiware Version 1.1 (Mixture Analysis Tool) Quick
Reference Guide (Part no. 4402094)

—  GeneMapper® ID-X Sofiware Version 1.2 Quick Reference Guide (Part
no. 4426482)
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Content in this chapter to come at PRC.
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that

occur during analysis.

Observation

Possible causes

Recommended actions

Faint or no signal from
both the 007 and the
DNA test samples at all
loci

Incorrect volume or absence of either
AmpF(STR® NGM™ Master Mix or
AmpF(STR® NGM™ Primer Set

Repeat amplification using correct reagent
volumes.

No activation of enzyme

Repeat amplification, making sure to hold
reactions initially at 95°C for 11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex Master Mix thoroughly.

AmpF(STR NGM™ Primer Set
exposed to too much light

Store Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

Tubes/plate not seated tightly in the
thermal cycler during amplification

Push reaction tubes/plate firmly into contact with
block after first cycle. Repeat test.

Wrong PCR reaction tubes or plate

Use Applied Biosystems MicroAmp Reaction
Tubes with Caps or the MicroAmp Optical 96-Well
Reaction Plate for the GeneAmp® PCR System
9700.

MicroAmp™ Base used with
tray/retainer set and tubes in
GeneAmp® PCR System 9700

Remove MicroAmp Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

For ABI PRrism® 3100-Avant or Applied
Biosystems 3100/3130x/ runs: Mix 1.0 pL of
PCR product and 10 pL of Hi-Di™ Formamide/
GeneScan™ 500 LIZ® Size Standard solution.

For Applied Biosystems 3500/ 3500xL
instrument runs: Mix 1.0 pL of PCR product and
10 pL of Hi-Di™ Formamide/ GeneScan™ 500
LIZ® Size Standard solution.

For ABI PRisM® 310 instrument runs: Mix

0.75 pL of PCR product and 24.25 pL of Hi-Di™
Formamide/ GeneScan™ 500 LIZ® Size Standard
solution.

Faint or no signal from
both the 007 and the
DNA test samples at all
loci (continued)

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR Control DNA
007 but partial or no
signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantify DNA and add 1.0 ng of DNA. Repeat
test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes

Quantify DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ Kit.

If possible, evaluate the quality of
DNA sample by running an agarose
gel. If DNA is degraded, reamplify
with an increased amount of DNA or
use the AmpF(STR® MiniFiler™ Kit.

Redilute DNA using low TE Buffer (with 0.1 mM
EDTA).

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

Interpret according to laboratory procedures.

Note: Additional information will be provided on
completion of validation.

Incomplete 3" A base addition
(n-1 nt position)

Addition of excess DNA to the reaction will
contribute to the occurrence of incomplete 3'
base addition. Quantify DNA and add 1.0 ng of
DNA to the reaction. Repeat test. Also be sure to
include the final extension step of 60°C for 10 min
in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure cycle number is optimized according to
instructions on page 26. Repeat PCR
amplification using fewer PCR cycles or use your
laboratory’s SOP to analyze off-scale data.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed
and used for analysis.

Too much DNA in reaction

Use recommended amount of template DNA
(1.0 ng) at 29 cycles; 500 pg at 30 cycles.

Incomplete denaturation of double
stranded DNA

Use the recommended amount of Hi-Di™
Formamide and perform heat denaturation
according to instructions on page 36.

Poor peak height Incorrect thermal cycler parameters Check the protocol for correct thermal cycler
balance parameters.
GeneAmp® PCR System 9700 with Use Applied Biosystems GeneAmp® PCR System
Aluminum 96-Well block or third- 9700 with silver or gold-plated silver blocks only.
party thermal cyclers
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Materials and equipment not included

The tables below list optional equipment and materials not supplied with the
AmpF(STR® NGM™ Kit. Unless otherwise noted, many of the items are available

from major laboratory suppliers (MLS).

Equipment

Source

Applied Biosystems 3500/3500xL Genetic Analyzer for Human Identification
ABI PRrism® 3100/3100-Avant Genetic Analyzer

Applied Biosystems 3130/3130x/ Genetic Analyzer

Applied Biosystems 310 Genetic Analyzer

Contact your local

Applied Biosystems
sales representative

GeneAmp® PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878
Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS
Item Source
3500/3500xL Analyzer materials
Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4™ polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4™ polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715

Note: For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems

3500/3500xL Genetic Analyzer User Guide (Part no. 4401661)
AmpF(STR® NGM™ PCR Amplification Kit (200x/1000x)

4415020/4415021
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Item Source
3100/3100-Avant Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560
250-uL Glass Syringe (array-fill syringe) 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731

Note: For a complete list of parts and accessories for the 3100 instrument, refer to Appendix B of the AB/ Prism® 3100

Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Part no. 4335393).
3130/3130x/ Analyzer materials

96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x/ Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4™ Polymer for 3130/3130x/ Genetic Analyzers 4352755
3130/3130x/ Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560

For a complete list of parts and accessories for the 3130x/ instrument, refer to Appendix A of the Applied Biosystems
3130/3130xI Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Part no. 4352716).

310 Analyzer materials

310 DNA Analyzer Capillary Array, 47-cm 402839
0.5 mL Sample Tray 5572
96-Well Tray Adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 4335643
Genetic Analyzer Septa Retainer Clips for 96-Tube Sample Tray 402866
Genetic Analysis Sample Tubes (0.5-mL) 401957
Septa for 0.5-mL Sample Tubes 401956
DS-33 Matrix Standard Set (6-FAM™, VIC®, NED™, PET®, and LIZ® dyes) for 4318159
ABI PRISM® 310/377 systems

MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 96-Well Base (holds 0.2-mL reaction tubes) N8010531

90 AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



Materials and equipment not included

Item Source
MicroAmp® 96-Well Full Plate Cover N8010550
MicroAmp® 96-Well Tray/Retainer Set 403081
POP-4™ Polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the ABI PRISM® 310 Genetic
Analyzer User Guide (Part no. 4317588).

PCR Amplification

MicroAmp® 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 8-Cap Strip N8010535
MicroAmp® 96-Well Tray/Retainer Set 403081
MicroAmp® 96-Well Base N8010531
MicroAmp® Clear Adhesive Film 4306311
MicroAmp® Optical Adhesive Film 4311971
MicroAmp® Optical 96-Well Reaction Plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS
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Safety

This appendix covers:

B Chemical safety . .......... . i 94
B Chemical wastesafety. ........ ... ... .. 96
B Biological hazard safety .......... .. ... ... . . . . . . 98
B Chemical alerts . ........ ... 99
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Chemical safety

Chemical hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer
warning to the Safety Data Sheet (SDS) provided by the manufacturer, and observe all
relevant precautions.

A WARNING! CHEMICAL HAZARD. All chemicals in the instrument,
including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

A WARNING! CHEMICAL STORAGE HAZARD. Never collect or store
waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines * Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. (See “About SDSs” on page 94.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the SDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

» Comply with all local, state/provincial, or national laws and regulations related
to chemical storage, handling, and disposal.

About SDSs Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments
of hazardous chemicals to new customers. They also provide SDSs with the first
shipment of a hazardous chemical to a customer after an SDS has been updated.
SDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to
replace the appropriate SDS in your files.
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Chemical safety

Obtaining The SDS for any chemical supplied by Applied Biosystems is available to you free
SDSs 24 hours a day. To obtain SDSs:

1. Go to www.appliedbiosystems.com, click Support, then select SDS.

2. In the Keyword Search field, enter the chemical name, product name, SDS part
number, or other information that appears in the SDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of
the following:

* Open — To view the document
* Print Target — To print the document

* Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the SDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.
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Chemical waste safety

Chemical waste A WARNING! HAZARDOUS WASTE. Refer to Material Safety Data Sheets

hazards

and local regulations for handling and disposal.

WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied
Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

ﬁ WARNING! CHEMICAL STORAGE HAZARD. Never collect or store

waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical waste To minimize the hazards of chemical waste:

safety guidelines .

Read and understand the Safety Data Sheets (SDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle,
or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste
material and meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the SDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national environmental
and health regulations.

Waste disposal If potentially hazardous waste is generated when you operate the instrument, you
must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.
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Chemical waste safety

Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide 97



Appendix C Safety

Biological hazard safety

General
biohazard

A\

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial,
and/or national regulations. Wear appropriate protective equipment, which
includes but is not limited to: protective eyewear, face shield, clothing/lab coat,
and gloves. All work should be conducted in properly equipped facilities using
the appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

+ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no.
017-040-00547-4; bmbl.od.nih.gov)

*  Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html)

*  Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov
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Chemical alerts

Chemical alerts

For the definitions of the alert words IMPORTANT, CAUTION, WARNING, and
DANGER, see “Safety alert words™ on page 7.

General alerts for  Avoid contact with skin, eyes, and/or clothing. Read the SDS and follow the handling
all chemicals instructions. Wear appropriate protective eyewear, clothing, and gloves.

Specific CAUTION! CHEMICAL HAZARD. AmpF{STR® NGM™ PCR
chemical alerts Amplification Kit may cause eye, skin, and respiratory tract irritation.
Sodium azide may react with lead and copper plumbing to form highly
explosive metal azides.

WARNING! CHEMICAL HAZARD. POP-4" Polymer for 3130/3130x/
Genetic Analyzers causes skin, eye, and respiratory tract irritation.

WARNING! CHEMICAL HAZARD. Running Buffer, 10 causes skin, eye,
and respiratory tract irritation.

WARNING! CHEMICAL HAZARD. Hi-Di" Formamide is harmful if
swallowed, inhaled or absorbed through skin, and causes irritation to
skin, eyes, and respiratory tract. It affects the central nervous system and
may affect the reproductive system.

WARNING! CHEMICAL HAZARD. POP-4" Polymer for 3100/3100-
Avant Genetic Analyzers is irritating to eyes, respiratory system, and skin.
It causes adverse cardiovascular effects. It contains a known or suspected
reproductive toxin and a known or suspected mutagen.

WARNING! CHEMICAL HAZARD. POP-7" Polymer for the 3730
Genetic Analyzer is harmful by inhalation and if swallowed and irritating
to eyes, respiratory system, and skin.

AmpF&TR® NGM™ PCR Amplification Kit User’s Guide 99



Appendix C Safety

100 AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



Documentation

Related documentation

For additional documentation, see “How to obtain support” on page 102.

Document title Part
number

ABI Prism® 3100/3100-Avant Data Collection v2.0 User Guide 4347102

ABI PrisM® 3100/3100-Avant Genetic Analyzers Using Data Collection 4350218

Software v2.0 User Bulletin

ABI PrisM® 3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834

ABI PrisM® 3100/3100-Avant Genetic Analyzers Protocols for Processing 4332345
AmpF&STR® PCR Amplification Kit PCR Products User Bulletin

AmpFSTR® NGM™ PCR Amplification Kit - PCR Setup Quick Reference 4442401
Card
AmpF&STR® NGM™ PCR Amplification Kit - CE Quick Reference Card 4442693

Applied Biosystems 3130/3100xI Genetic Analyzers Using Data Collection 4363787
Software v3.0 User Bulletin

Applied Biosystems 3130/3130xI Genetic Analyzers Getting Started Guide 4352715

Applied Biosystems 3130/3130xI Genetic Analyzers Maintenance, 4352716
Troubleshooting, and Reference Guide

Applied Biosystems 3130/3130xI Genetic Analyzers Quick Reference Card 4362825

Applied Biosystems 3130/3130xI Genetic Analyzers AB Navigator Software 4359472
Administrator Guide

Applied Biosystems 3130/3100xI DNA Analyzers User Guide 4331468

Applied Biosystems 3730/3730xI Genetic Analyzer Getting Started Guide 4359476

Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® | 4344790
Y Human Male DNA Quantification Kit User’s Manual

PrepFiler™ Forensic DNA Extraction Kit User Guide 4390932
GeneMapper® ID Software Version 3.1 Human Identification Analysis User 4338775
Guide

GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification 4335523
Analysis Tutorial

Installation Procedures and New Features for GeneMapper® ID Software 4352543
v3.2 User Bulletin

GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Getting Started 4396773
Guide
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Documentation

Part

Document title number

GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Quick Reference = 4402094
Guide

Portable document format (PDF) versions of this guide and the documents listed
above are available at www.appliedbiosystems.com

Note: To open the user documentation available from the Applied Biosystems web
site, use the Adobe® Acrobat® Reader® software available from www.adobe.com

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
» Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, SDSs, certificates of analysis, and
other related documents.

* Download PDF documents.
* Obtain information about customer training.

+ Download software updates and patches.
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